University of California
Hastings College of the Law

Content Editor/Component Administrator Guide
# Table of Contents

Overview........................................................................................................................................... 5
Requirements ......................................................................................................................................... 5
Logging In................................................................................................................................................ 5
Cascade Interface .................................................................................................................................. 6
  Main Navigation Menu ......................................................................................................................... 6
  Assets & Asset Tree ............................................................................................................................... 7
Page Editing Navigation Menu ............................................................................................................... 8
Rich Text Editor ..................................................................................................................................... 8
Editing Tools .......................................................................................................................................... 9
  HTML Editor ....................................................................................................................................... 11
  HTML Tips .......................................................................................................................................... 11
Non-editable Site-wide Design Elements ............................................................................................... 12
  Header ............................................................................................................................................... 12
  Footer ................................................................................................................................................ 12
Templates Types .................................................................................................................................... 13
Navigation Types ................................................................................................................................... 14
Navigation Relationships ....................................................................................................................... 16
  Cascade Asset Tree .............................................................................................................................. 16
  Breadcrumbs ........................................................................................................................................ 17
  Left Column Navigation ....................................................................................................................... 17
Understanding System Name, Title and Display Name .......................................................................... 18
Universal Page ...................................................................................................................................... 19
  Creating a New Folder with a Universal Page ...................................................................................... 21
  Creating a New Page Not Contained in a Folder .................................................................................. 22
Managing Universal Page Content ........................................................................................................ 23
Add/Edit Page Title, Display Name, and Edit Body Copy ....................................................................... 23
Inserting Links, Files, Anchors and Images ............................................................................................ 23
  Uploading an image to Cascade Server ............................................................................................... 23
  To Insert a Link (internal or external) and file into existing text ....................................................... 23
  To Insert an Email address into existing text ..................................................................................... 24
  To Insert a Anchor into existing text on the same page .................................................................... 24
  Adding a Banner Bank ....................................................................................................................... 25
  Adding an Explicit Banner Image ............................................................................................... 25
  Adding Related Links ......................................................................................................................... 25
Overview
This document provides an overview of the editing basic web page types (Standard Page, Standard Page with Tabs, and News Article) as well as referencing existing external components for these page types using the Cascade Server CMS for the http://www.uchastings.edu/ website.

Requirements
Cascade Server offers full support for the following major browsers, including: Internet Explorer 7+, Firefox 4+, Safari 3+, and Chrome.

Logging In
Logging into the Cascade Server CMS allows an editor to view, create, and manage existing assets and pages.

- Open a supported web browser.
- Access https://atlas.uchastings.edu:8443/ via the URL text field.
- Enter your username, as supplied by your site administrator, in the “Username” text field.
- Enter your password, as supplied by your site administrator, in the “Password” text field.
- Click the “Login” button.

Note: Although most screens display inline, make sure to turn off any popup blockers for this site.
Note: JavaScript is required in order to work within the CMS. See the CMS Requirements section within this documentation.
Cascade Interface

Upon logging in, the Home Dashboard tab will be visible. The Dashboard provides links to the following areas.

Note: Some functionality may be hidden based on your permission level.

The dashboard consists of 4 tabs:

- **Dashboard** - offers quick access for creating content, outstanding items, and recently viewed assets.
- **Messages** - used to display system messages as well as messages from other editors to the editor.
- **Workflows** - displays all the editor's active workflows.
- **Locks** - displays a list of all the assets checked out by the current editor.

Main Navigation Menu

Standard content editors will generally have the following menu items available in the Main Navigation Menu (some functionality may be hidden based on your permission level):

- Home – “Home” link will bring the editor back to the dashboard.
- New – The “New” menu contains the assets available to add to the site. (This is customizable by the Admin)
- History – The “History” link will display a list of your most recently viewed assets.
- Tools – The “Tools” menu contains the system functionality to ‘Search’ through cascade, ‘Publisher’ to publish the site, ‘Import’ to import files to cascade, the ‘System’ menu/tools and ‘Preferences’ to customize email, editor preferences, etc.
• Administration – The “Administration” link is only accessible to the Admin Role. This screen enables the Admin to edit users, configuration, content types, asset factories, data definitions, metadata, publish sets, target and destinations, transports, workflow definitions and view reports.

**Assets & Asset Tree**

Cascade server refers to any component used to generate content as assets. For example all pages, files, blocks, style sheets, external links, folders, templates and references are all considered assets.

The assets are viewable and arranged within the asset tree, which will always be available on the left column within Cascade Server. The asset tree displays the folder navigation and a hierarchical view of the website’s assets.
Page Editing Navigation Menu

- View tab – Contains the Preview link to review changes prior to publishing.
- Edit tab – Enables the editor to edit the content of the page. Also contains the Metadata area and System area.
  - Content area – Default display allows the editor to add/edit content.
  - Metadata area – Editor has the ability to enter an author, review date, and designate dates in which the page should be published to the public. Note: Start and end dates are dependent upon a publish process occurring after the date entered and do not initiate their own publish process at the specified time.
  - System area – Ability to change the system name, modify the parent folder, content types, configurations and metadata.
- Copy tab – Ability to copy page to another folder.
- Publish tab – Ability to immediately publish page to target.
- More tab – Includes the Delete menu, Access menu, Reference menu and Versions menu.

Rich Text Editor
The Cascade Server software comes with content rich text editor or WYSIWYG editor (WYSIWYG is an acronym for “What You See Is What You Get”). It is has a wide range of functionality and the features are similar to most word processing software.
**Editing Tools**

**Insert Special Characters** – Inserts characters like copyright ©, trademark ™, etc. A dialog box with a host of selections will assist you.

- **Subscript** – This makes text a subscript.
- **Superscript** – This makes text a superscript.
- **Bold** – Bolds text.
- **Italic** – Italicizes text.
- **Underline** – Underlines text. It is highly recommended that editors limit the use of this tool because underlining is universally associated with hyperlinks on a web page. Bold and/or italics are better ways to emphasize text on a web page.
- **Strikethrough** – This tool puts a strike through text.
- **Flush Left** – Left-aligns text.
- **Flush Center** – Centers text.
- **Flush Right** – Right-aligns text.
- **Flush Justify** – Justifies text.

- **Styles** – Applies a style sheet to the selected text.
- **Format** – Applies formatting to selected text. e.g Heading 1, Heading 2, etc.

- **Cut** – This will cut selected text out for pasting later.
- **Copy** – This will copy selected text out for pasting later.
- **Paste** – This will paste text that has either been cut or copied.
- **Paste From Word** – This will paste content that has either been cut or copied from Word and usually will retain the same text formatting.
**Find and Replace** – This tool will find the specified text, then if desired, replace it with the text entered.

**Spellcheck** – Checks your spelling.

**Unordered List** - This tool inserts a bulleted list.

**Ordered List** - This tool inserts a numbered list.

**Indent** – Indents text.

**Outdent** – Outdents text.

**Undo** – Cancels the action you just performed.

**Redo** – Basically this will undo an Undo.

**Insert Link** – This will insert a hyperlink.

**Remove Hyperlink** – Removes hyperlink from selected text.

**Insert or Edit Anchor** – This will insert or edit an anchor.

**Insert or Edit Image** – This will insert or edit an image.

**Horizontal Rule** – This creates a horizontal line to divide the text.

**Clean up messy code** – Removes unneeded coding syntax.

**Remove formatting** – Deletes text formatting.

**HTML** – Edit HTML source code.

**Toggle guidelines/invisible elements** – A realistic view of your page while creating it.

**Toggle fullscreen mode** – Change to fullscreen view.

**Spacing in Cascade Server**

The [Enter] key in the Text Editor will create a new paragraph or paragraph tag in HTML <p>.

The [Shift]+[Enter] key in the Text Editor will create a line break or break tag in the HTML <br/>. 
**HTML Editor**
If you would like to edit the HTML code itself, you may click the HTML button to switch to HTML mode. Once you have made all the requisite changes to the page, click the Update button.

**HTML Tips**
It is highly suggested that formatting be used conservatively to maintain the integrity of the site design.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;p&gt;&lt;/p&gt;</td>
<td>Paragraph tag</td>
</tr>
<tr>
<td>&lt;br /&gt;</td>
<td>Line break tag</td>
</tr>
<tr>
<td>&lt;h1&gt;Text&lt;/h1&gt;</td>
<td>Header tags H1 is the largest, H6 is the smallest. Must have a closing tag</td>
</tr>
<tr>
<td>&lt;hr&gt;</td>
<td>Horizontal line</td>
</tr>
<tr>
<td>&lt;b&gt;Text&lt;/b&gt;</td>
<td>Bold text within the tags.</td>
</tr>
<tr>
<td>&lt;i&gt;Text&lt;/i&gt;</td>
<td>Italicize text within the tags.</td>
</tr>
<tr>
<td>&lt;ul&gt;</td>
<td>Bullet list</td>
</tr>
<tr>
<td>&lt;li&gt;Text&lt;/li&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;li&gt;Text&lt;/li&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;/ul&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ol&gt;</td>
<td>Number list</td>
</tr>
<tr>
<td>&lt;li&gt;Text&lt;/li&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;li&gt;Text&lt;/li&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;/ol&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;a href=&quot;Link URL&quot;&gt;Link Text&lt;/a&gt;</td>
<td>Hyperlink tags</td>
</tr>
<tr>
<td>&lt;center&gt;Text&lt;/center&gt;</td>
<td>Center text on page.</td>
</tr>
</tbody>
</table>
Non-editable Site-wide Design Elements

Header

The page header appears at the top of pages and will remain consistent through the site.

Footer

The footer appears at the bottom of the page and will remain consistent throughout the site.
Templates Types

Before attempting to create pages within the system, the editor must understand what types of pages are available and how these items interact with one another. Pages are created from templates and each template serves a specific purpose.

As a content editor where you create a page will determine the type of template created. The majority of the pages you will create will be Universal Subpages and/or News Articles. This guide will cover how to create and edit pages as well as how to include Column Components.

There are additional templates that are covered in detail in the Functional Specifications document.

- Home Page
- Universal Subpage
- News Listing
- News Article
- Admissions
- Gateway
- Units & Centers Home v1
- Units & Centers Home v2
- Units & Centers Home v3
- Units & Centers Landing v1
- Units & Centers Landing v2
- Units & Centers Landing v3
Navigation Types

There are five types of navigation on the pages of the site. These five types will be referenced throughout this document.

Primary Navigation

Tactical Navigation

Gateway Navigation

Ancestor Navigation

Contextual Navigation
• Primary Navigation. The Primary Navigation consists of elements that will display on every page regardless of the visitors location in the site. This navigation is static and not editable.

• Ancestor Navigation (breadcrumbs). The Ancestor Navigation shows the current location of the user in the content tree. The current page is shown as well as all ancestor pages back to the home page. This navigation is dynamic and will automatically display based on the creation of the pages in the CMS.

• Contextual Navigation. The Contextual Navigation will display the current location in the content tree, and will show the selected page’s siblings and children in the tree structure. The display of the left navigation will follow the information architecture of the site. This navigation is dynamic and will automatically display based on the creation of the pages in the CMS.

• Tactical Navigation. The Tactical Navigation links are visible on each page of the site. This navigation is static and not editable.

• Gateway Navigation (audience). The Gateway Navigation links to audience gateway pages and is visible on each page of the site. This navigation is dynamic and will automatically display based on the creation of the pages in the CMS.
Navigation Relationships

Relationships are defined by the location of an item within the asset tree structure. These relationships in the asset tree dynamically create the left column navigation and the breadcrumbs that are displayed on the website. For example, when a new child page is created it will automatically appear in the left hand navigation and breadcrumb.

- Parent - An asset that contains another asset.
- Children - Assets that are contained within another asset.
- Sibling - Assets that appear on the same level and have the same parent.

Cascade Asset Tree

We will consider “About” our root page. This will be our “Parent”.

These are “Children” of the “Parent” page. They are “siblings” of one another.

These are “Children” of “Visit”. They are also “Grand Children” of “About”. They are “siblings” of one another.
Breadcrumbs

This is the “Current Page”.

These are “Children” of the “Current Page”. They are “Siblings” of one another.

“Parent” of “Current Page”

Left Column Navigation

These are “Children” of the “Parent” page. They are “Siblings” of one another.

This is the “Current Page”.

These are “Children” of the “Current Page”. They are “Siblings” of one another.
Understanding System Name, Title and Display Name

Names for files/folders are used within the asset tree and other names are used as references within the navigation that appears on the published site. Below details which fields display where within the system or the site.

**Used on Published site:**

- **Folder Title**
  - Current not employed within the design.
- **Folder Display Name**
  - Displays in the Ancestor Navigation.
  - Displays in the Contextual Navigation.
- **Folder System Name**
  - Displays in the Published URL.
  - Becomes a Folder within the Live Folder.
- **Page Title**
  - Displays in the Ancestor Navigation at the Current Page level.
  - Displays in the Contextual Navigation (if not contained within a folder).
- **Page Display Name**
  - Displays at the top of the Body Content region
- **Page System Name**
  - Displays in the Published URL.
  - Becomes a File within the Live Server (the extension is added during the publishing process).

**Internal System Usage:**

- **Folder System Name**
  - Displays in the asset tree.
- **Page System Name**
  - Displays in the asset tree.

**System File path** – Displays at the top of every page within the system and displays the full file path to the page.
Universal Page
The Universal Page design is intended to be a flexible page that can be used for anywhere within the site structure. It is intended to be the workhorse page for content throughout the website and will be used often.

The following elements are unique to this page:

1. Banner Bank or Explicitly Selected Image.
   a. The content editor can select a banner image bank for the page. The banner image banks will contain one or more banner images that will rotate randomly on page load if more than one image is in the bank.
   b. If an Explicit Image is selected, it will be displayed in place of any selected Banner Bank.
   c. If no image is selected the body content will move up the page.

2. Body Content.
   a. The center column contains a single rich text field for the body copy. The Content Editor will use the built-in rich text editing capabilities to apply sub-title, heading, block quote and other styles to the text. The system will ensure the correct styles are applied so the text matches the design when displayed on the page. However, site-specific styles will be available within the WYSIWYG editor.

3. Left Column SPIFs.
a. The content editor can specify one or more SPIF items, described later in this document, to display in the left column of the page.
Creating a New Folder with a Universal Page

It is recommended to create a folder with an index page. This is so that editor can create children pages or folders for this section. Cascade Server will read the folder names to generate the Contextual and Ancestor Navigation pieces.

1. Open a supported browser.
2. Access the URL: https://atlas.uchastings.edu:8443
   - Enter your “Username” in the text box provided.
   - Enter your “Password” in the text box provided.
   - Click “Log In”
3. Select the “Home” link within the main navigation (a horizontal strip along the top of the page).
   - Note: If a “tree view” is not visible click the small, red, right facing arrow located at the top left of the page. This will allow the “tree view” panel to slide-out from the left margin of the page.
   - Note: The “tree view” may look different from user to user and is dependent upon the permissions of the currently logged in account.
4. Select “UCHastings.edu” from the sites menu (a dropdown located at the top of the page).
5. Select the “+” symbol next to the “Base Folder” folder.
   - This will expand the tree and show you files located within this site.
   - Note: Once permissions have been setup, you may have limited access to the pages that you can view, access, or edit.
6. Select the “New” link within the main navigation.
7. Select “New/Page Types” from the “popup” menu and click on “Folder with Universal Page.”
   - Note: The right window pane will be replace with a form requesting information for the folder to be created.
8. In the “System Name” text box enter the name the folder will be called within the CMS.
   - Note: The “System Name” should NOT contain and special characters (spaces, dashes, quotes, etc.)
   - Note: the “System Name” will become part of the published URL path for the page.
9. Using the tree structure, browse to the “parent” page of where you would like to create the new folder and “child” page.
10. In the Inline Metadata group, enter a “Display Name” for the folder.
11. In the Inline Metadata group, enter a “Title” for the folder.
12. Click the “Submit” button.
Creating a New Page Not Contained in a Folder

If a page will never have any children pages then it can be created without a folder. Cascade will see that there is no folder (equaling no children pages) and know the title of the page should display in the left navigation and breadcrumbs.

Note: It is recommended to create each page as a folder with an index page, regardless if it is has children or not, so in the future if children were needed it would be an easy addition. This also makes managing Contextual Navigation impossible for the page.

Note: This Asset Factory (menu item) may not be available based on your permissions.

1. Open a supported browser.
2. Access the URL: https://atlas.uchastings.edu:8443
   - Enter your “Username” in the text box provided.
   - Enter your “Password” in the text box provided.
   - Click “Log In”
3. Select the “Home” link within the main navigation (a horizontal strip along the top of the page).
4. Select the “+” symbol next to the “Base Folder” folder.
   - This will expand the tree and show you files located within this site.
   - Note: Once permissions have been setup, you may have limited access to the pages that you can view, access, or edit.
5. Select the “New” link within the main navigation.
6. Select “New/Page Types” from the “popup” menu and click on “Universal” or other, appropriate, page type.
7. In the “System Name” text box enter the name the folder will be called within the CMS.
   - The “System Name” should NOT contain and special characters (spaces, dashes, quotes, etc.)
8. Using the tree structure, browse to the “parent” page of where you would like to create the new “child” page.
9. In the Inline Metadata group, enter a “Display Name” for the page.
10. In the Inline Metadata group, enter a “Title” for the page.
11. Click the “Submit” button.
Managing Universal Page Content

Add/Edit Page Title, Display Name, and Edit Body Copy

These instructions apply to all template types.

1. Select the newly created index page from the content tree.
2. Click the “Edit” tab.
3. In the Inline Metadata group, enter a “Display Name” and “Title”.
   ○ Note: Select names thoughtfully as they will be used within automatically generated navigation and as page contents.
4. In the “Main Content/Content Body Copy” rich text editor enter the page’s body text.
5. Click “Submit” or “Save Draft” button.

Inserting Links, Files, Anchors and Images

These instructions apply to all template types.

Note: To insert a link to any type of file (.doc, .pdf, .jpg, .gif, etc.) the item must be loaded into Cascade server; unless it is an external link on a public domain.

Uploading an image to Cascade Server

1. Navigation to the appropriate parent folder.
2. Select the “New” link within the main navigation.
3. Select “Default” from the “popup” menu and click on “File”.
4. In the Inline Metadata section, enter a “Display Name”, “Title”, “Summary”, and “Author”.
5. In the Data section, select “Choose File” to browse to the image file to upload it into the system.
6. Click “Submit” when complete.

Note: This set of instructions can also be applied to upload files.

To Insert a Link (internal or external) and file into existing text

1. Open a page to edit in the Rich Text Editor and select the text you would like to link.
2. Select the Hyperlink icon available in the upper toolbar and the Insert/Edit Link dialog box will appear.
3. Select the Internal or External radio button.
4. Fill out the remaining fields and click “Insert”
5. To find a file, image or internal page within the CMS, click on the “Link” button.
To Insert an Email address into existing text
1. Open a page to edit in the Rich Text Editor and select the text you would like to link to an email address.
2. Select the Hyperlink icon available in the upper toolbar and the Insert/Edit Link dialog box will appear.
3. Select the External radio button.
4. In the “Link” field type `mailto:email@address.com`. “mailto:” should precede the email address.
5. Enter a title which will be the alt tag and appear when a user hovers over the link.
6. Click “Insert”.

To Insert a Anchor into existing text on the same page
This is a two-step process. A. Create the anchor (where the links would direct the user). B. Create the link.

A. Create the anchor
1. Open a page to edit in the Rich Text Editor and select the text you would like to apply the anchor to.
2. Select the Anchor icon available in the upper toolbar and the Insert/edit Anchor dialog box will appear.
3. Enter an anchor name and click “Insert”. (Remember the name you enter, you will reference it in the next step.)

B. Create the link
1. Highlight the text you would like to link to the anchor.
2. Select the Hyperlink icon available in the upper toolbar and the Insert/edit Link dialog box will appear.
3. Enter the anchor name assigned in section A into the field name “Anchor”.
4. Click “Update”.

**Adding a Banner Bank**

1. Select the page in the content tree.
2. Click on the “Edit” tab in the Page Editing Navigation menu.
3. Locate the “Main Content/Banner Bank” field.
4. To include a banner bank, use the “Banner Bank” chooser icon to select an existing bank.
5. Click the “Submit” button at the bottom of the page to save the page.

Note: Banner banks, in general, will be located within the “Base Folder/_components/bannerBanks/” directory.

Note: The banner banks are created and maintained by the Site Administrator. To add or remove a banner from a particular bank or to have a new banner bank created, contact the Site Administrator.

**Adding an Explicit Banner Image**

1. Select the page in the content tree.
2. Click on the “Edit” tab in the Page Editing Navigation menu.
3. Locate the “Main Content/Explicit Banner Image” field.
4. To include an explicit banner image, use the “Explicit Banner Image” chooser icon to select an existing image.
5. Click the “Submit” button at the bottom of the page to save the page.

Note: Banner images, in general, will be located within the “Base Folder/_site_support/images/banners” directory.

Note: An Explicit Banner Image will override a Banner Bank if both fields contain content.

**Adding Related Links**

1. Select the page in the content tree.
2. Click on the “Edit” tab in the Page Editing Navigation menu.
3. Locate the “Related Links” section.
4. Adjust the “Related Links Header” if necessary.
5. To include a Related Link, use the “Related Links/Related Link - Individual” fields to select an Internal Link (using the page chooser icon) or by entering External Link Text and an External Link URL.
   - To add additional Related Links, click the “+” sign beneath the “Related Links/Related Link – Individual” section header.
   - Once there is more than one Related Link they may be sorted using the directional arrows.
6. Click the “Submit” button at the bottom of the page to save the page.

Note: Make sure that any External Link URLs begin with http://
Note: In addition to adding multiple Related Links within a single Related Links Section, you may also add additional Related Links Sections (each containing from one to many links).

**Adding Column Components**

1. Select the page in the content tree.
2. Click on the "Edit" tab in the Page Editing Navigation menu.
3. To include column component, use the “Column Content/Column Component” chooser icon to select the component from an existing bank.
   - To add additional components, click the “+” sign to the right of the word “Column Component.”
4. Click the “Submit” button at the bottom of the page to save the page.

Note: The component banks are created and maintained by the Site Administrator. To add or remove a component from a particular bank, contact the Site Administrator.

**Removing Column Components**

1. Navigate to the page that contains the element you would like to remove and open the page for editing by clicking on the “Edit” tab.
2. Click on “Cancel” icon next to the component you would like to remove.
   - You may also select the “-” sign to the right of the word “Column Component” in order to remove the field row. This is recommended if there is no reference within the field row.
3. The file path will now be blank.
   - The field will be removed if you selected used the “-“ selection.
4. Click “Submit” or “Save Draft” to save.
**News Article**
This landing page is intended for news content on the site that will be syndicated to the home page and other pages using SPIFs.

The following elements are unique to this template type:

1. **Header Image**
   a. This image can be specified by the content editor to display in the white content area of the page, below the headline and date.

2. **Body Content.**
   a. The center column contains a single rich text field for the body copy. The Content Editor will use the built-in rich text editing capabilities to apply sub-title, heading, block quote and other styles to the text. The system will ensure the correct styles are applied so the text matches the design when displayed on the page.
   
   b. Additionally, for news stories, the content editor will select:
      i. A published date for the story
      ii. One or more categories (Alumni, Admissions, etc.) for the story

3. **Share icons.**
   a. Sharing icons will appear in the right column to allow the user to share, email, print, etc.
Creating a News Article

A News Story is slightly different than other page types as it is generally NOT an index page. These pages, rather, sit with a defined folder structure based on their release date.

1. Open a supported browser.
2. Access the URL: https://atlas.uchastings.edu:8443
   - Enter your “Username” in the text box provided.
   - Enter your “Password” in the text box provided.
   - Click “Log In”
3. Select the “Home” link within the main navigation (a horizontal strip along the top of the page).
   - Note: If a “tree view” is not visible click the small, red, right facing arrow located at the top left of the page. This will allow the “tree view” panel to slide-out from the left margin of the page.
   - Note: The “tree view” may look different from user to user and is dependent upon the permissions of the currently logged in account.
4. Select “UCHastings.edu” from the sites menu (a dropdown located at the top of the page).
5. Select the “+” symbol next to the “Base Folder” folder.
   - This will expand the tree and show you files located within this site.
   - Note: Once permissions have been setup, you may have limited access to the pages that you can view, access, or edit.
6. Using the tree structure, browse to the “parent” page of where you would like to create a new “child” page.
   - In the instance of a News Article this directory is generally located at “Base Folder/news/articles/YEAR/MONTH” where the YEAR and MONTH will be the release date of the article.
7. Select the “New” link within the main navigation.
8. Select “New/Page Types” from the “popup” menu and click on “News Article.”
   - Note: The right window pane will be replace with a form requesting information for the folder to be created.
9. In the “System Name” text box enter the name the News Article will be called within the CMS.
   - Note: The “System Name” should NOT contain and special characters (spaces, quotes, etc.)
10. In the Inline “Metadata” group, enter a “Display Name” for the article.
11. In the Inline “Metadata” group, enter a “Title” for the article.
12. In the “Taxonomy” group, select the appropriate “Categories” for the article.
   - These “Categories” will be used to filter News Article Listings for inclusion on other page types.
13. In the “Main Content” group, enter a “Teaser” for the article.
14. Click the “Submit” button or continue editing the News Article.
Managing News Article Content

1. Select the newly created News Article from the content tree.
2. Click the “Edit” tab.
3. In the “News Article” section, enter a “Release Date” in the appropriate field.
4. In the “Main Content” section, select/enter the following:
   - Thumbnail Image – used in News Listings.
   - Large Image – used within the content of the page
   - Image Caption – used beneath the large image in the content of the page.
   - In the “Content Body Copy” rich text editor enter the article’s body text.
5. Click “Submit” or “Save Draft” button.

Note: The News Article allows the same Related Links and Column Content functionality as the Standard Page. Please refer to the Standard page documentation in order to manage Related Links and Column Content.
Submitting a Page to Workflow or Save Draft

As a content editor there are two choices when saving a page.

- Submit to workflow. Clicking “Submit” will release the page to be published at the next scheduled publish and release the page for others to view or edit.
- Save Draft. Clicking “Save Draft” will save the changes but the changes will only be available to the editor who made the edits and the changes will not be included in the next scheduled publish.
Managing Navigation

**Editing the Sort Order of the Left Navigation**
1. Select the “Home” link within the Main Navigation (a horizontal strip along the top of the page).
2. Select the “+” symbol next to the “Base Folder” folder.
3. Using the asset tree, browse to the “parent” folder of where you would like to sort the children pages.
4. Clicking on the parent folder will default to the “View” tab and “Contents” sub-category. A list of all of the children of that folder will display.
5. Within the column labeled “Actions” click on the arrow buttons to move the pages to the order in which you wish them to display.

Note: You may also “Drag & Drop” the order of items by clicking on the “Order” column header.

**Showing/Hiding the left column navigation**
1. Select the “Home” link within the Main Navigation (a horizontal strip along the top of the page).
2. Select the “+” symbol next to the “Base Folder” folder.
3. Using the asset tree, browse to the “parent” folder of where you would like to sort the children pages.
4. Clicking on the folder will default to the “Edit” tab and “Metadata” sub-category. In the “Custom Metadata” section, adjust the value of the “Show in Navigation” dropdown to show the “Siblings and Children”, “Children Only”, or “None”.

**How To link to an external page**
You may not always want to create a new page but rather add a link to an external site that will display in the left column navigation.

1. Select the “Home” link within the main navigation (a horizontal strip along the top of the page).
2. Select the “+” symbol next to the “Base Folder” folder.
3. Using the tree structure, browse to the “parent” page of where you would like to create a new “child” page.
4. Select the “New” link within the main navigation.
5. Select “Default” from the “popup” menu and click on “External Link.”
6. In the Inline Metadata group, enter a “Display Name” and “Title” for the link.
7. In the “Link” text box enter the link’s URL.
8. Click “Submit” to save.

**Previewing a Page**

1. Navigate to the page that contains the element you would like to remove and open the page for editing by clicking on the “View” tab.
2. Click on the “Preview” button contained in the View tab.
   - You can view the PHP or XML – Dev View output.
Managing Components
Components are “pieces” of web pages rather than a web page in and of itself. These components are created by a content administrator and then added to multiple pages throughout the site by various content editors.

Banner Bank
A Banner Bank is included on basic page types and will randomly display a single banner instance from the bank on referencing pages.

Creating a Banner Bank

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
3. Select “New/Components/Banner Bank”.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. To include a Banner, use the “Banner Bank/Banner” fields to select an image (using the file chooser icon.
7. Enter an appropriate title in the “Banner Title/Alt Text” field.
8. To add additional Banners, click the “+” sign beneath the “Banner” section header.
9. Click the “Submit” button at the bottom of the page to save the page.

Note: This Banner Bank is now available to be included in the appropriate component location on pages throughout the site. Make sure that the Banner Bank is published so there are no broken connections on referencing pages within the live site.
**Events Listing**

An Events Listing is included in multiple page types and will display a formatted listing of items pulled from the specified RSS feed.

**Creating an Events Listing**

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
3. Select “New/Components/Events Listing”.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. Connect to a well-formed RSS feed.
   - This can be done via the “Events Listing/RSS – Internal Link” field or the “Events Listing/RSS – External Link” field.
7. Specify the “Maximum Items” that should be displayed within the listing.
8. Specify the Footer Link and Text.
   - The link itself can be either an Internal or External reference.
9. Click the “Submit” button at the bottom of the page to save the page.

Note: This Events Listing is now available to be included in the appropriate component location on pages throughout the site. Make sure that the Events Listing is published so there are no broken connections on referencing pages within the live site.

Note: Although the intention of the Events Listing was to connect to an “events” RSS feed (supplied by Active Data Exchange), any well-formed RSS feed should be able to render. Test each rendering before connecting to live pages.

**Active Date Exchange – Creating an RSS Feed**

An Active Data Exchange RSS feed can be filtered for inclusion within and Event.

**Creating an Active Data Exchange RSS Feed**

1. Access the calendar at http://ade.uchastings.edu
2. Click the "RSS" icon.
3. Select "Next Future Events" (maybe set 20 as the default).
4. Click "Submit"
5. Grab the URL of the page (sample: http://ade.uchastings.edu/RSSSyndicator.aspx?category=&location=&type=N&binary=Y&keywords=&number=20)
6. Go into the CMS
7. Create a "New/Components/Events Listing"
8. Fill out the required fields... use the external RSS URL you just grabbed.
9. Click "Submit"
10. Add the new events listing component to the appropriate component locations.

Note: "Law Events" and an "Academic Events" calendar have been created as examples within the CMS. Notice the difference between the two (the academics is a filtered calendar and has a "category" parameter)...

Law Events:


Note: Make sure that the feed URL is in a format that is available outside the local network. “http://” is correct rather than “feed://” and “ade.uchastings.edu” is correct rather than “ade.uchastings.local.”
Feature
The Feature is a complex component used on a handful of page types (Home Page, News Listing, and Centers). These components are kept separate from the pages they are included within. This is to allow creation of numerous components that can be switched easily.

Creating a Feature

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
3. Select “New/Components/Banner Bank”.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. To include a Feature Slide, click the “+” sign under the “Feature/Feature Slide” group.
7. Each Feature Slide allows the following fields:
   - Image
   - Image Caption
   - Tagline
   - Teaser
   - Related Links
     1. Header
     2. Internal and Internal Link References
        - YouTube ID
        - YouTube Caption
8. To add additional Feature Slides, click the “+” sign under the “Feature/Feature Slide” group.
   - Slides may be reordered using the up and down arrows next to each “Feature Slide” group.
9. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.
News Listing

The News Listing is a basic component used to pull in a specified number of News Articles based on a supplied index block.

Creating a News Listing

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
3. Select “New/Components/Events Listing”.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. Select an existing index block using the “News Listing/News Listing Block” field.
7. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.

Note: This component is not used on standard pages but allows different listing types to be created. This is helpful for the creation of archive pages but is less likely to be used elsewhere on the site.
SPIF Bank – Multi-Purpose

The Multi-Purpose SPIF is included in multiple page types and will display a block containing a formatted rich text block allowing randomized content that displays in a pre-defined style and location.

Creating a SPIF Bank – Multi-Purpose

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
3. Select “New/Components/ SPIF Bank – Multi-Purpose”.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. To include a SPIF, use the “SPIF – Multi-Purpose” field to enter the desired content.
7. To add additional SPIFS, click the “+” sign beneath the “SPIF – Multi-Purpose” section header.
8. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.

Note: Although the rich text field allows any content, editors must be careful to note the locations in which the SPIF bank will be referenced in order to make sure that the content fits the allotted area.
**SPIF Bank - RSS Feed**

The RSS SPIF is included in multiple page types and will display a block containing a sliding display of items contained in a specified RSS feed.

**Creating a SPIF Bank - RSS Feed**

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. To include a RSS Feed, use the fields within the “SPIF – RSS” section.
7. Use the “Block Title” field to enter the header that is to display above the sliding RSS items.
8. Connect to a well-formed RSS feed.
   - This can be done via the “Select Internal Link - RSS” field or the “External Link URL - RSS” field.
9. Specify the “Maximum Items” that should be displayed within the listing.
10. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.

Note: Any well-formed RSS feed *should* be able to render. Test each rendering before connecting to live pages.
SPIF Bank – Slideshow
The Slideshow SPIF is included in multiple page types and will display a block containing a single image with a caption. Upon clicking on the image/caption, a slideshow will overlay on top of the current page allowing the end user to view the specified images.

Creating a SPIF Bank - Slideshow

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. Enter a “Block Title” in the field provided.
   o This title will display at the top of all SPIFs located in this bank.
7. To include an individual slide, use the “SPIF Bank – Slideshow/SPIF - Slideshow” fields to enter the desired content.
8. Select an image using the “Image” field browse button.
9. Enter the caption to be associated with the slide in the “Caption” field.
10. To add additional slides, click the “+” sign beneath the “SPIF – Slideshow” section header.
11. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.
SPIF Bank – Standard

The Standard SPIF is included in multiple page types and will display a block that randomly displays preformatted information.

Creating a SPIF Bank - Standard

1. Log into the system.
2. Select “UCHastings.edu” from the site menu.
4. In the “System Name” text box enter the name the component will be called within the CMS.
5. Enter a “Display Name” and “Title” for the component.
6. Enter a “Block Title” in the field provided.
   - This title will display at the top of all SPIFs located in this bank.
7. To include an individual SPIF, use the “SPIF Bank – Standard/SPIF - Standard” fields to enter the desired content.
8. Enter the title to be associated with the SPIF in the “Title” field.
   - You may connect the Title to an external or internal link if required.
   - This can be done via the “Title Link - Internal” field or the “Title Link - External” field.
9. Enter the sub title to be associated with the SPIF in the “Sub Title” field.
10. Enter the teaser to be associated with the SPIF in the “Teaser” rich text field.
11. Select an image using the “Image” field browse button.
12. Enter a YouTube ID to be associated with the SPIF in the “YouTube ID” field.
   - The YouTube ID can be found within the URL string of any YouTube video. It is the value of the “V” parameter.
   - Example: http://www.youtube.com/watch?v=YOURTUBEIDHERE
   - Note: If both an Image and a YouTube ID are entered, the YouTube ID will take priority.
13. To add additional slides, click the “+” sign beneath the “SPIF – Slideshow” section header.
14. Click the “Submit” button at the bottom of the page to save the page.

Note: This component is now available to be included in the appropriate locations on pages throughout the site. Make sure that the component is published so there are no broken connections on referencing pages within the live site.
Managing the Site

The following one-off components, page types, and management pieces are created and maintained by the site administrator.

Emergency Alert

The Emergency Alert is a banner that contains information that can quickly be deployed across all of the pages of all of the sites. This is intended for use in emergency situations and alerts.

Creating a Title

1. Log into the CMS system.
2. Enter the "UCHastings.edu" Project.
3. Select "Base Folder/_includes/alert/index".
4. Click the "Edit" tab.
5. Enter a Display Name, Title, Alert Name, Alert Content.
6. Select and Internal or External Link for "More Information".
7. Check the "Show Alert" checkbox.
8. Publish the page.

Note: To remove the alert, simply uncheck the "Show Alert" checkbox and republish the page.

Site Duplication

How to duplicate and existing site by hand.

Note: This method is secondary to the automatic site duplication method as detailed below.

Duplicating a Site by Hand

1. Select the “Swirl Logo/Site Management”.
   - Create a New Site.
     1. Enter the site name.
     2. Enter the site URL.
     3. Click Submit.
       1. Add the appropriate Roles/Groups to the site.
   2. Go to existing site and copy the following to the new site.
     - Asset Factories
     - Base assets
     - Content Types
     - Configuration Sets
     - Global Assets (that will be different on this site)
       1. Header
       2. Footer
     - Edit the Configuration Set to point to the new Global Assets.
     - Edit the Content Types to point to the new Configuration Sets.
     - Edit the Base Assets to point to the new Content Types.
- Edit the Asset Factories to point to the new Base Assets.
- Edit the Paths within the Asset Factories.
- Adjust the publishing transports and destinations.

Note: You may need to duplicate a directory structure. If you do, remove any existing pages or manually change them to point to the updated Content Types.

Note: Site cloning removes the above steps. This is available beginning in version 7.

**Site Duplication**
How to duplicate a site using the “Site Copy” option (v7+).

Note: This method is preferred over duplicating a site by hand but must be checked more thoroughly.

**Duplicating a Site by Using “Site Copy”**

1. Log into the system.
   - An Administrator level account must be used for the following steps.
2. Click the “swirl” icon located at the top/left of the navigation bar.
3. Select “Site Management” from the “swirl” contextual menu.
4. Select “Sample Sub Site” from the site listing.
5. Select the “Export” tab within the right pane.
6. Select the “Export” button.
   - Your system will now download a CSSE file.
7. Click the “swirl” icon located at the top/left of the navigation bar.
8. Select “Site Management” from the “swirl” contextual menu.
9. Select the “Import Site” link within the right pane.
10. Enter your new site name in the “Name” field.
11. Select “Choose File.”
13. Select “Submit.”
14. Wait...
   - You can see your upload status within the browser status bar.
15. After importing is complete, a new (clean) site will be available within your site listing.

**Sub Sites Search**
How to setup a sub-site level search index.

**Creating a Sub Site Search**

1. Create a new Sub Site.
2. Create a Google Site Search account tied to the new Sub Site.
3. Log into the CMS system.
4. Select the new Sub Site from the Sites drop-down.
5. Navigate to the ".site_support/scripts/search.js" file.
6. Click the "Edit" tab.
7. Enter the Search ID (this can be found in the script supplied by the Google Site Search code).
8. Enter the Search URL (this is generally in the format of "http://subdomain.uchastings.edu/search").
9. Enter the Search Name (this will display next to the radio button).
10. Click the "Submit" button.
11. Publish the updated "search.js" file.

**News Article Categories**
How to add a News Article Category for Taxonomy.

**Adding Categories**

1. Log into the system as an administrator.
2. Select "Administration/Data Definitions" from the main menu.
3. Select "Page Types/News Articles" from the "Data Definitions" menu in the left column.
4. Click the "Edit" tab in the right window pane.
5. Click the "XML" sub tab.
6. Duplicate an existing "selector-item" line (under the "categories" node) and paste it in the location of the new selection (usually alphabetical).
7. Change the "value" attribute of the new line to reflect your new category.
8. Click "Submit."

Note: Make sure to add the same value to the "Data Definitions/components/filtered news" if you would like editors to be able to create filtered news lists based off of the new category.

**Filter Selections for Filtered News Components**
How to add a Filter Selection to the Filtered News Component.

**Adding Filter Selections**

1. Log into the system as an administrator.
2. Select "Administration/Data Definitions" from the main menu.
3. Select "Components/Filtered News" from the "Data Definitions" menu in the left column.
4. Click the "Edit" tab in the right window pane.
5. Click the "XML" sub tab.
6. Duplicate an existing "dropdown-item" line (under the "categories" node) and paste it in the location of the new selection (usually alphabetical).
7. Change the "value" attribute of the new line to reflect your new category.
8. Click "Submit."

Note: Make sure to add the same value to the "Data Definitions/Page Types/News Articles" if you would like editors to be able to select this category on News Article Page types.
Managing the Site - Samples

Sample Workflow - Article (Reference Only)

**Sample Code**

```xml
<system-workflow-definition name="1 Step" initial-step="first-step">
  <triggers>
    <trigger name="merge" class="com.cms.workflow.function.Merge" />
    <trigger name="email" class="com.cms.workflow.function.EmailProvider" />
    <trigger name="publish" class="com.cms.workflow.function.Publisher" />
    <trigger name="version" class="com.cms.workflow.function.Version" />
    <trigger class="com.cms.workflow.function.PublishSetTrigger" name="publishSet" />
  </triggers>
  <steps>
    <step type="system" identifier="first-step" label="Initialization">
      <actions>
        <action identifier="initialize" label="Init" type="auto" move="forward">
          <trigger name="email">
            <parameter>
              <name>mode</name>
              <value>notify</value>
            </parameter>
          </trigger>
        </action>
      </actions>
    </step>
    <step type="system" identifier="finalize-edit" label="Merging and Publishing">
      <actions>
        <action identifier="finalize" label="Finalize" type="auto" move="forward">
          <trigger name="merge" />
          <trigger name="version" />
          <trigger name="publish" />
          <trigger name="publishSet">
            <parameter>
              <name>name</name>
              <value>/Path to location</value>
            </parameter>
          </trigger>
        </action>
      </actions>
    </step>
    <step type="system" identifier="finished" label="Finished" />
  </steps>
</system-workflow-definition>
```
Sample Workflow – Article Delete (Reference Only)

Sample Code

```xml
<system-workflow-definition name="1 Step - Delete and un-publish" initial-step="initialize">
  <!-- triggers that will be available to actions in the workflow -->
  <triggers>
    <trigger name="email" class="com.cms.workflow.function.EmailProvider" />
    <trigger name="publish" class="com.cms.workflow.function.Publisher" />
    <trigger name="delete" class="com.cms.workflow.function.DeleteAndUnpublish" />
    <trigger class="com.cms.workflow.function.PublishSetTrigger" name="publishSet" />
  </triggers>
  <!-- steps that should happen in order -->
  <steps>
    <step identifier="initialize" type="system" label="Initialization">
      <actions>
        <action identifier="initialize" type="auto" move="forward">
          <trigger name="email" />
        </action>
      </actions>
    </step>
    <step identifier="finalize-delete" type="system" label="Deleting">
      <actions>
        <action identifier="finalize" type="auto" move="forward">
          <trigger name="delete" />
          <trigger name="publishSet">
            <parameter>
              <name>name</name>
              <value>/Publish set location</value>
            </parameter>
          </trigger>
          <trigger name="email" />
        </action>
      </actions>
    </step>
    <step identifier="deleted" type="system" label="Deleted">
    </step>
  </steps>
  <!-- non ordered steps -->
  <non-ordered-steps>
    <step identifier="cancelled" type="system" label="Cancelled">
    </step>
  </non-ordered-steps>
</system-workflow-definition>
```
Sample Workflow – 2 Step with Edit (Reference Only)

Sample Code

```xml
<system-workflow-definition name="2 Step – With Edit" initial-step="initialize">
  <triggers>
    <trigger name="merge" class="com.cms.workflow.function.Merge" />
    <trigger name="email" class="com.cms.workflow.function.EmailProvider" />
    <trigger name="assignToWorkflowOwner" class="com.cms.workflow.function.AssignToWorkflowOwner" />
    <trigger name="publish" class="com.cms.workflow.function.Publisher" />
    <trigger name="version" class="com.cms.workflow.function.Version" />
  </triggers>
  <steps>
    <step type="system" identifier="initialize" label="Initialization">
      <actions>
        <action identifier="initialize" label="Init" type="auto" move="forward">
          <trigger name="email" />
        </action>
      </actions>
    </step>
    <step type="transition" identifier="editor" label="Law Editor" default-user="username">
      <actions>
        <action identifier="reject-to-edit" label="Back to Edit" next-id="edit-content">
          <trigger name="email" />
          <trigger name="assignToWorkflowOwner" />
        </action>
        <action identifier="approve" label="Approve" move="forward">
          <trigger name="email" />
        </action>
        <action identifier="publish-now" label="Approve and Finish" next-id="finalize-edit">
          <trigger name="email" />
        </action>
        <action identifier="Revise-Content" label="Revise Content" next-id="edit-content" />
      </actions>
    </step>
    <step type="system" identifier="finalize-edit" label="Finalizing">
      <actions>
        <action identifier="finalize" label="Finalize" type="auto" move="forward">
          <trigger name="version" />
          <trigger name="merge" />
          <trigger name="email" />
        </action>
      </actions>
    </step>
    <step type="system" identifier="completed" label="Completed">
      <actions>
      </actions>
    </step>
  </steps>
</system-workflow-definition>
```
<step type="system" identifier="published" label="Published" />
</steps>
<non-ordered-steps>

<step type="edit" identifier="edit-content" label="Revise Content" default-user="username">

<actions>
  <action identifier="edit" label="Edit" type="auto" next-id="editor" />
</actions>
</step>
</non-ordered-steps>
</system-workflow-definition>
Sample LDAP Configuration (Reference Only)

Sample Configuration
Note: See: http://help.hannonhill.com/kb/ldap/configuring-ldap-in-10-easy-steps

<ldap-synchronization-configuration>
<!-- ldap system options -->
<options>
<is-enabled>yes</is-enabled>
<automatic-synchronization>no</automatic-synchronization>
<!-- for users in the system that were not addressed in the migration can be either 'ignore' or 'remove' or 'deactivate' -->
<orphaned-ldap-users>ignore</orphaned-ldap-users>
<server>
<ldap-version>3</ldap-version>
<hostname>10.20.20.20</hostname>
<port>389</port>
<security>
<username>CN=John Smith,OU=Employees,DC=hannonhill,DC=com</username>
<password>secretpassword</password>
</security>
<auth-type>simple</auth-type>
(binding>
<classname>com.hannonhill.cascade.model.security.ldap.bind.LDAPCleartextBind</classname>
.parameter>
<name>javax.net.ssl.keyStore</name>
<value>C:/Java/jdk/jdk1.5.0_06/jre/lib/security/keystore</value>
</parameter>
<parameter>
<name>javax.net.ssl.keyStorePassword</name>
<value>anothersecretPassword</value>
</parameter>
<parameter>
<name>trust-server-certificate</name>
<value>yes</value>
</parameter>
</binding>
</server>
<!-- this section must be present if a report is to be generated -->
<report>
<generate-report>yes</generate-report>
<send-to-email>person@company.com</send-to-email>
</report>
</options>
<!-- if automatic synchronization is enabled -->
<schedule>
<repeat-every>1</repeat-every>
<!-- may be seconds, minutes, hours, days -->
<repeat-time-unit>hours</repeat-time-unit>
</schedule>
<!-- group and role policies -->
<policies>
<user-policy summary="Main Employees">
<container-identifier>OU=Employees,DC=hannonhill,DC=com</container-identifier>
<object-attribute-filter>
  <name>objectCategory</name>
  <value>CN=Person,CN=Schema,CN=Configuration,DC=hannonhill,DC=com</value>
</object-attribute-filter>

<username-attribute>sAMAccountName</username-attribute>
<email-attribute>userPrincipalName</email-attribute>
<full-name-attribute>displayName</full-name-attribute>

<authenticate-against-ldap-server>yes</authenticate-against-ldap-server>
<enable-new-users>yes</enable-new-users>
<convert-usernames-to-lowercase>yes</convert-usernames-to-lowercase>
<authentication-mode>ldap</authentication-mode>

<system-groups remove-from-other-groups="no">
  <group>
    <name>development</name>
  </group>
</system-groups>

<system-roles remove-from-other-roles="no">
  <role>Manager</role>
</system-roles>

</user-policy>
</policies>
</ldap-synchronization-configuration>